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RX63N Group 
Speaker Enhancement Algorithms 

Introduction 
This document introduces the sample project for the speaker enhancement algorithms developed for RX600 series 
devices by Berkeley Design Technology, Inc (BDTI). 

Target Device 
RX63N 

• This sample application is designed to operate on the YRDKRX63N demonstration board. 

Related Documents 
• BDTI Speaker Compensation Application Note: BDTI_AppNote_RX63N_Speaker_Compensation.pdf 

• R01AN1465ES0100: RX Family RX DSP Library version 2.0 (CCRX) 

• R01AN1707EU0100: Audio Player Sample Application: MP3, WAV, ADPCM – This application note 
contains Renesas sample code that supports playback of MP3 and IMA-ADPCM file types. 

• R01AN1816EU0100: Ogg Vorbis Decoder Sample Application – This application note contains Renesas 
sample code that supports playback of Ogg Vorbis file types. 

• FAT FS; FAT files system module.  Open-source software available from  
http://elm-chan.org/fsw/ff/00index_e.html 
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1. Overview 
This document describes how to open the speaker enhancement sample project in Renesas e2 studio and download the 
sample code to the RX63N RDK board.  For detailed information about the algorithms and how to tune them for other 
applications, refer to the BDTI application note.  The BDTI application note is located in the documents folder of the 
sample project: BDTI_AppNote_RX63N_Speaker_Compensation.pdf. 

1.1 Hardware Requirements 
The following hardware is required for this demo: 

• YRDKRX63N demonstration board. 

• Micro SD memory card with .wav audio files (not included with RDK) 

• (Recommended) External stereo speaker or headphones with 1/8" stereo jack: The effects of the enhancement 
algorithms are typically more noticeable with an external speaker.  See section 6.1 for further information on 
speaker recommendations. 

1.2 Development Environment 
The following Renesas software tools are required for this demo: 

• Renesas e2 studio IDE: This project was developed using v2.1.0.21. 

• RX Compiler CC-RX: This project was developed using v1.02.01 

These tools can be downloaded from the Renesas website here: 
http://am.renesas.com/products/tools/ide/ide_e2studio/downloads.jsp 

1.3 MCU Resources Used by this Application 
This application requires use of a few of the RX6xx microcontroller's peripheral modules to communicate with the 
SDCard memory and to run the demo. The following hardware resources are required: 

1. One "Serial Peripheral Interface (RSPI)" channel. (Required for SDCard communication.) 

2. One "Compare Match Timer (CMT)" channel. (Used for timed delays in SDCard driver code.)  

3. The "Data Transfer Controller (DTC)" for streaming PWM timer data to the TPU timers. 

4. Three "TPU" timer channels.  

5. "Real-time clock (RTC)". Not essential for audio playback, but it is used for file data and time stamping by the 
application. 

6. 12-bit ADC. The "ADC12" is used for measuring the audio playback volume setting by potentiometer VR1. 

7. One serial "SCI" channel, used as a UART for optional RS232 communications to support an external player 
control UI. 

1.4 Supported Toolchains 
The demo source code is available for the following toolchain: 

• Renesas RX Toolchain v1.02.01 

1.5 Integer Types 
This project uses ANSI C99 “Exact width integer types” in order to make the code clearer and more portable. These 
types are defined in stdint.h. 

http://am.renesas.com/products/tools/ide/ide_e2studio/downloads.jsp
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2. Importing the sample project 
The application is distributed as an e2 studio archive file located in the application note archive file.  Extract the 
application note archive file (an_r01an1868eu0100_rx63n_sound.zip) to a known location, for example C:\Renesas.  In 
the extracted folder, you will find the e2 studio project archive file: 

• BDTI_RX_Speaker_Compensation.zip 

Note that this is not a standard archive file and it should not be extracted using standard archive tools.  Follow the 
instructions below to import the archive file using the project import feature in Renesas e2 studio. 

2.1 Import the sample project into Renesas e2 studio 
Follow these steps to import the speaker enhancement sample project into Renesas e2 studio. 

1. Open Renesas e2 studio: Start > All programs > Renesas Electronics e2 studio > Renesas e2 studio. 

2. In the Workspace Launcher dialog box, type C:\Workspace\RX_Speaker.  This will create a new folder for 
your workspace.  You should see an empty workspace in e2 studio. 

3. In e2 studio, go to File > Import. 

4. Open the General folder, and select Existing Projects into Workspace. Click Next. 

 
5. Click the radio button for Select archive file, then Browse to the project archive file 

BDTI_RX_Speaker_Compensation.zip.  Click Finish.  

 
6.   You should see the project BDTI_RX_Speaker_Compensation in your workspace. 
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3. Build and Download 
Now that the project has been imported, follow these steps to build the code and download it to the RX63N RDK board. 

1. Set the active build configuration to HardwareDebug.  Highlight the project, then go to Project > Build 
Configurations > Set Active > HardwareDebug (debug on hardware). 

NOTE: If the “Set Active” option is not available, make sure the project folder is highlighted in the project 
explorer. 

2. Build the project: Project > Build Project.  You should see a message in the console window indicating that 
the build is complete. 

 
3. Make sure SW5 is set to debug (OFF, OFF, OFF, ON).  Connect the J-LINK USB port on the RDK board to 

your computer using the provided USB A-miniB cable. 

NOTE: There are two USB ports on the RX63N RDK board.  Make sure to the J-LINK USB port located 
above the LCD next to the DB9 serial connector, not the USER USB port on the bottom right. 

4. Insert a micro SD card with .wav (uncompressed PCM) audio files.  The SD card slot is located in the bottom 
left corner of the RDK.  See section 4 for detailed information on supported file formats. 

NOTE:    Take care inserting or removing the micro SD Card from the slot on the YRDKRX63N. It should go 
in or out in a straight direction aligned with the slot. The micro SD Card is fragile and can be damaged or 
cracked by excessive off-center pressure.  For further information on loading the SD card, refer to section 6.2. 

5. To use an external speaker or headphones, remove the jumper JP7 connecting the on board speaker and 
connect the external speaker or headphones to the AUDIO OUT jack on the right side of the board. 

NOTE: External speakers or headphones are not required, but the effects of the enhancement algorithms are 
typically more noticeable with an external speaker.  See section 6.1 for further information on speaker 
recommendations. 

6. Connect to the board: Go to Run > Debug Configurations.  Open Renesas GDB Hardware Debugging and 
select BDTI_RX_Speaker_Compensation.x.  Click Debug. 

 
7. Click Resume .  If execution breaks at main, click Resume  again.  The LCD will display the message 

“RENESAS YRDKRX63N PCM Audio” and prompt you to press SW3 to continue. 

8. Press SW3.  SW3 is located to the left of the LCD screen. 

9. Follow the instructions on the screen to navigate the demo using the debugger. 

10. When the music is playing, you can press SW2 and SW3 to switch between using the BDTI algorithms and not 
using them. The different audio qualities in these two modes should be easily distinguishable. 

NOTE: Turn the potentiometer VR1 to adjust volume.  See section 6.4 for recommendations. 

11. To select a different folder, press the reset button (SW4) to reset the RX63N RDK board.  

12. Switch to standalone mode at any time by clicking Terminate .  Make sure to click Terminate before 
disconnecting the USB cable. 



RX63N Group Speaker Enhancement Algorithms 

R01AN1868EU0100  Rev.1.00  Page 5 of 6 
December 9, 2013  

4. Supported Audio File Formats 
Audio files in the 16-bit PCM .wav format can be selected from the browser for playback. 

Table 1 Supported Audio File Formats 

Audio file type  File 
extension 

Decoded Sample 
size 

44.1 
kHz 

32.0 
kHz 

22.05 
kHz 

11.025 
kHz 

Stereo Mono 

Uncompressed 
PCM 

.wav 16-bits ○ ○ ○ ○ ○ ○ 

 

5. Important Software for Speaker Enhancement 
On top of the original Renesas audio sample application, the package adds two important components: 

• BDTI speaker compensation software for the RX600 processor: The software is written in C. The source code 
files can be found under the subfolder “BDTI_RX_Speaker_Compensation/source/src/bdti”. 

NOTE: For detail about the BDTI speaker compensation software, refer to the BDTI application note in the 
documents folder of the BDTI_RX_Speaker_Compensation project. 

• Renesas RX DSP (Digital Signal Processing) library version 2.0: There are four variants. One and only one of 
them should be linked into the project. For details about the RX DSP library refer to the application note 
R01AN1465ES0100: RX Family RX DSP Library version 2.0 (CCRX). 

6. Audio Demo FAQ 
6.1 What speaker would you recommend? 
External speakers or headphones are recommended because the effects of the algorithms will be more noticeable using a 
better quality speaker.   

NOTE: The speaker compensation algorithms are tuned to perform wave shaping based on the speaker response 
characteristics.  This project is tuned for the speaker on the RDK, and an external speaker would have a different ideal 
configuration.  Even though the tuning will not be ideal with external speakers, the difference between playback with 
and without enhancement will be more distinct.  Refer to the BDTI application note in the documents folder of the 
sample project (BDTI_AppNote_RX63N_Speaker_Compensation.pdf) for further details on tuning the algorithms for a 
different speaker. 

6.2 How do I load audio files on the micro SD Card? 
Audio files may be copied to the micro SD-Card by any PC with a SD-Card slot. They can be located in any directory 
with the limitation that the fully qualified path string to the file must be 64 characters or less. The fully-qualified path 
string includes the drive letter or number, colon, backslash, all subdirectories leading to the file, and the filename itself. 
For example:  "E:\audio\music\somefile.wav" (without quotes) is a valid path, containing 27 characters. (In the audio 
player demo application, the drive letter "E:" will be represented as a number; "1:").  

6.3 Why do the file names look strange on the SD card? 
While browsing the files it may be noticed that some file names are displayed as shortened versions. The file-system in 
this application is limited to showing file names in the 8.3 format, due to patent restrictions on long filenames. Only the 
file name displayed has been changed; the actual file name stored on the media remains unchanged with its original 
long filename. 

6.4 How do I control Volume? 
Once an audio file of the uncompressed PCM type has been found and playback has been started, the volume control 
becomes active. LEDs on the board will illuminate to provide a visual indicator of the current volume setting. Volume 
control is provided by the potentiometer "VR1" on the YRDK board. Turn VR1 clockwise to increase the volume or 
counter-clockwise to decrease it. 

NOTE: Volume control is accomplished by scaling down the PWM output, which can reduce dynamic range.  For best 
sound quality, turn the volume all the way up (fully clockwise) and adjust volume on external speakers. 
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Website and Support 
Renesas Electronics Website 

http://www.renesas.com/ 
 
Inquiries related to the RX device or the RX Audio Demo 

http://www.renesas.com/contact/ 
 
Inquiries related to BDTI speaker enhancement algorithms 

http://www.bdti.com/contact 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
All trademarks and registered trademarks are the property of their respective owners. 
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General Precautions in the Handling of MPU/MCU Products 
The following usage notes are applicable to all MPU/MCU products from Renesas. For detailed usage notes on the 
products covered by this manual, refer to the relevant sections of the manual. If the descriptions under General 
Precautions in the Handling of MPU/MCU Products and in the body of the manual differ from each other, the 
description in the body of the manual takes precedence. 

1. Handling of Unused Pins 
Handle unused pins in accord with the directions given under Handling of Unused Pins in the manual. 
 The input pins of CMOS products are generally in the high-impedance state. In operation with an 

unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of LSI, an 
associated shoot-through current flows internally, and malfunctions occur due to the false 
recognition of the pin state as an input signal become possible. Unused pins should be handled as 
described under Handling of Unused Pins in the manual. 

2. Processing at Power-on 
The state of the product is undefined at the moment when power is supplied. 
 The states of internal circuits in the LSI are indeterminate and the states of register settings and 

pins are undefined at the moment when power is supplied. 
In a finished product where the reset signal is applied to the external reset pin, the states of pins 
are not guaranteed from the moment when power is supplied until the reset process is completed. 
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function 
are not guaranteed from the moment when power is supplied until the power reaches the level at 
which resetting has been specified. 

3. Prohibition of Access to Reserved Addresses 
Access to reserved addresses is prohibited. 
 The reserved addresses are provided for the possible future expansion of functions. Do not access 

these addresses; the correct operation of LSI is not guaranteed if they are accessed. 
4. Clock Signals 

After applying a reset, only release the reset line after the operating clock signal has become stable. 
When switching the clock signal during program execution, wait until the target clock signal has 
stabilized. 
 When the clock signal is generated with an external resonator (or from an external oscillator) 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. 
Moreover, when switching to a clock signal produced with an external resonator (or by an external 
oscillator) while program execution is in progress, wait until the target clock signal is stable. 

5. Differences between Products 
Before changing from one product to another, i.e. to one with a different type number, confirm that the 
change will not lead to problems. 
 The characteristics of MPU/MCU in the same group but having different type numbers may differ 

because of the differences in internal memory capacity and layout pattern. When changing to 
products of different type numbers, implement a system-evaluation test for each of the products. 



 

 

 

Notice
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples.  You are fully responsible for

the incorporation of these circuits, software, and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from the

use of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics does not warrant that such information is error free.  Renesas Electronics

assumes no liability whatsoever for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of third parties by or arising from the use of Renesas Electronics products or

technical information described in this document.  No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or

others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.  Renesas Electronics assumes no responsibility for any losses incurred by you or

third parties arising from such alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality".  The recommended applications for each Renesas Electronics product depends on

the product's quality grade, as indicated below.

       "Standard": Computers; office equipment; communications equipment; test and

       equipment; and industrial robots etc.

       "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-crime systems; and safety equipment etc.

       Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial

       implantations etc.), or may cause serious property damages (nuclear reactor control systems, military equipment etc.).  You must check the quality grade of each Renesas Electronics product before using it

in a particular application.  You may not use any Renesas Electronics product for any application for which it is not intended.  Renesas Electronics shall not be in any way liable for any damages or losses

incurred by you or third parties arising from the use of any Renesas Electronics  product for which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, especially with respect to the maximum rating, operating supply voltage

range, movement power voltage range, heat radiation characteristics, installation and other product characteristics.  Renesas Electronics shall have no

       use of Renesas Electronics products beyond such specified ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have specific characteristics such as the occurrence of failure at a certain rate and

malfunctions under certain use conditions.  Further, Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement

       possibility of physical injury, and injury or damage caused by fire in

      redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because the evaluation of microcomputer software alone is very difficult,

please evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to

       products in compliance with all applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive.  Renesas Electronics assumes

no liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or

regulations.  You should not use Renesas Electronics products or technology described in this document for any purpose relating to military applications or use by the military, including but not limited to the

development of weapons of mass destruction.  When exporting the Renesas

       regulations and follow the procedures required by such laws and regulations.

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or otherwise places the product with a third party, to notify such third party in advance of the

contents and conditions set forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as a result of unauthorized use of Renesas Electronics

products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries.

(Note 2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.

the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including but not limited to

environmental matters such as the environmental compatibility of each Renesas Electronics product.  Please use Renesas Electronics

liability for malfunctions or damages arising out of the

safety measures to guard them against the

life support devices or systems, surgical

http://www.renesas.com
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